


บทน ำ
Cisco Webex Events คือ Webinar หรือกำรสัมมนำออนไลน์ ที่จะเปิดให้ทั้ง

ผู้น ำเสนอหรือผู้ร่วมอภิปรำยเข้ำร่วมได้พร้อมกันไม่จ ำกัดและสำมำรถให้สิทธิ
ผู้เข้ำร่วมสัมมนำออนไลน์ได้แบ่งปันควำมรู้และควำมคิดเห็นกันได้ผ่ำนช่องทำง
ออนไลน์ทั้งหมด ไม่ว่ำจะเป็น PC หรือ  mobile phone  และผู้น ำเสนอสำมำรถแชร์
หน้ำจอตัวเอง เพื่อเปิดสไลด์หรือน ำเสนอ Demo ต่ำงๆ แชทโต้ตอบได้ ท ำโพล
สอบถำมได้ มี Q&A ที่ผู้เข้ำร่วมกำรสัมมนำออนไลน์สำมำรถถำมผู้น ำเสนอได้
โดยตรงและตอบกลับแบบส่วนตัวได้

โดย Cisco Webex Events ห้องหนึ่งสำมำรถส่งอีเมล์ลงทะเบียนได้ 10000
คน แต่รับเข้ำห้องสัมมนำออนไลน์ 1000 คนพร้อมๆ กันเท่ำนั้น
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บทน ำ
กำรตั้งค่ำใช้งำน Cisco Webex Events
กำรลงทะเบียนกำรเข้ำร่วมกิจกรรม Cisco Webex Events
ขั้นตอนกำรใช้งำน Cisco Webex Events
ขั้นตอนกำรใช้งำน Poll Cisco Webex Events 

หน้ำ
2
4
27
37
60



กำรตั้งคำ่ใช้งำน
Cisco Webex Events 
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1. เข้ำที่เว็บไซต์ mahidol.webex.com
พิมพ์ช่ือ.นำมสกุล@mahidol.ac.th 
คลิกท่ีปุ่ม Next

2. ที่ Username และ Password พิมพ์
ชื่อ.นำมสกุลและรหัสผ่ำนท่ีใช้งำน คลิกท่ี
ปุ่ม Sign in

3. จะปรำกฏหน้ำกำรเข้ำใช้งำน Cisco Webex จำกนั้นคลิกที่ข้อควำม 
Webex Events 

Webex Events
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4. จะปรำกฏหน้ำกำรเข้ำใช้งำน Cisco Webex Event  จำกนั้นคลิกที่ข้อควำม 
Schedule an Event

Schedule an Event

5. จะปรำกฏหน้ำกำรตั้งค่ำใช้งำน Schedule an Event

6. ที่ข้อควำม Basic Information  มีกำรตั้งค่ำต่ำงๆดังน้ี
Event type : Online Event 
Event name : …………………. ตั้งชื่อที่ต้องกำรใช้งำน
Listed on pubic calendar : สำมำรถตั้งค่ำแสดงในปฏิทินสำธำรณะได้
Delete from My Meetings when completed : เมื่อใช้งำนเสร็จส้ินระบบจะลบข้อมูลนี้ออก
Registration : Required  บังคับต้องลงทะเบียนเทำ่นั้น
Event password : ระบบจะตั้งค่ำโดยอัติโนมัติ
Program : สำมำรถเลือกกำรใช้งำนโปรแกรมต่ำงๆที่สร้ำงขึ้นได้ที่ปุ่ม add a new program 
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7. ที่ข้อควำม Date & Time มีกำรตั้งค่ำต่ำงๆดังนี้
Start date : เลือก วัน เดือน ปี ที่ต้องกำรใช้งำน
Start Time : เลือกช่วงเวลำที่ต้องกำรใช้งำน ตำม Time Zones ดังนี้

8. ที่ Start Time : เลือกช่วงเวลำ
ที่ต้องกำรใช้งำน แล้วคลิกที่ 
Plan event time zone จะปรำกฏ
หน้ำต่ำง Select Time Zones ที่ช่อง 
Participants Time Zone คลิก
เครื่องหมำย +

9. จะปรำกฏช่อง Participants Time Zone 2 คลิกเลือก time zones
ที่ต้องกำรใช้งำน แล้วคลิกที่ปุ่ม Show Time 

Show Time 
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10. จะปรำกฏหน้ำต่ำง Time Zone Planner แสดงเวลำเปรียบเทียบระหว่ำง 
Time Zone ขึ้นมำ ตรงนี้สำมำรถพิจำรณำช่วงเวลำที่เหมำะสมได้ จำกนั้นคลิกที่
ปุ่ม Select Time ที่ช่องจะปรำกฏ Time Zone ที่ได้เลือกไว้แสดงข้ึนมำ

Select Time

11. ที่ข้อควำม Date & Time มีกำรตั้งค่ำต่ำงๆ
Estimated duration : เลือกระยะเวลำโดยประมำณที่ต้องกำรใช้งำน
Time Zone  : จะแสดง Time Zoneต่ำงๆที่ต้องกำรใช้งำน
Email reminder : เลือกเวลำกำรแจ้งอีเมล์เตือนล่วงหนำ้ก่อนเปดิระบบใช้
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12. ที่ข้อควำม Audio Conference settings
Select Conference type : เลือก Use VoIP only 
เพื่อเปิดโอกำสให้ผู้เข้ำร่วมกิจกรรมสำมำรถพูดโต้ตอบได้ 
โดย Host จะเป็นผู้มอบสิทธิ์นั้นระหว่ำงกิจกรรม

13. ที่ข้อควำม Event Description & Options มีกำรตั้งค่ำต่ำงๆดังนี้

14. ที่ข้อควำม Event Description & Options มีกำรตั้งค่ำต่ำงๆดังนี้
Description : ใส่รำยละเอียดต่ำงๆในกำรใช้งำนนี้

จำกนั้นคลิกที่ปุ่ม Upload
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15. จะปรำกฏหน้ำต่ำง Upload Your Picture คลิกที่ปุ่ม เลือกไฟล์
จำกนั้น เลือกไฟล์ภำพ ที่ต้องกำรใช้งำน แล้วคลิกที่ปุ่ม Open

16. ที่หน้ำต่ำง Upload Your Picture คลิกที่ปุ่ม Upload
จะปรำกฏภำพที่ต้องกำรใช้งำนขึ้นมำ 

17. ที่ Host image คลิกที่ปุ่ม Upload จะปรำกฏ
หน้ำต่ำง Upload Your Picture คลิกที่ปุ่ม เลือกไฟล์ 
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18. จำกนั้นเลือกไฟล์ภำพที่ต้องกำรใช้งำนแล้วคลิกที่ปุ่ม Open
ที่หน้ำต่ำง Upload Your Picture คลิกที่ปุ่ม Upload

19.จะปรำกฏภำพที่ต้องกำรใช้งำนขึ้นมำที่
Host image

20. ที่ Event material คลิกที่ปุ่ม Upload จะปรำกฏหน้ำต่ำง Add Event material 
คลิกที่ปุ่ม เลือกไฟล์ จำกนั้นเลือกไฟล์ภำพที่ต้องกำรใช้งำนแล้วคลิกที่ปุ่ม Open
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21. หน้ำต่ำง Add Event material จะปรำกฏไฟล์ข้ึนมำคลิกที่ปุ่ม Upload

เมื่อ Upload File เสร็จสิ้นจะปรำกฏ
ชื่อไฟล์นั้นข้ึนมำ เลือกที่ไฟล์นั้น แล้ว
คลิกที่ปุ่ม Add

22. ที่ Event material จะปรำกฏชื่อไฟล์นั้นขึ้นมำและสำมำรถใส่รำยละเอียดของ
ไฟล์นั้นได้ 

23. ที่ Other UCF options : เลือกกำรตั้งค่ำที่ระบบก ำหนดไว้

UCF (Universal Communications Format)

Do not allow attendees to share rich media files in this event
ไม่อนุญำตให้ผู้เข้ำร่วมประชุมแชร์ไฟล์ส่ือ
Request attendees to verify rich media players
ขอให้ผู้เข้ำร่วมประชุมตรวจสอบโปรแกรมเล่นไฟล์ส่ือ
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24. ที่ Who can view the attendee list : เลือกกำรตั้งค่ำที่ระบบก ำหนดไว้

All participants : ให้ผู้เข้ำร่วมประชุมเห็นผู้เข้ำร่วมประชุมทั้งหมด 
Only the host, presenter, and panelists :
ให้ผู้เข้ำร่วมประชุมเห็นเฉพำะ host , ผู้น ำเสนอ และ กลุ่มผู้บรรยำย 

25. ที่ Video : Turn on video เลือกกำรตั้งค่ำที่ระบบก ำหนดไว้

ที่ Post-event survey : เลือกกำรตั้งค่ำที่ระบบก ำหนดไว้

ที่ Destination URL after event : ใส่ URL ที่ใช้งำนหลังจบกิจกรรม

(จำกกำรทดสอบสำมำรถใช้งำนได้ที่ https://mahidol.webex.com/ เท่ำนั้น)

26. ที่ข้อควำม Attendees & Registration มีกำรตั้งค่ำต่ำงๆ
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27. ที่ Attendees คลิกที่ Create 
invitation list จะปรำกฏหน้ำต่ำง Create 
Attendee Invitation List คลิกที่ปุ่ม 
Select Contacts เฉพำะที่มีรำยชื่อ
ที่เคยใช้งำนมำแล้ว

Select Contacts

28. จะปรำกฏหน้ำต่ำง Select Attendees from Your Contacts คลิกที่
รำยชื่อที่ต้องกำรเชิญร่วมกิจกรรม จำกนั้นคลิกที่ปุ่ม Add Attendees

Add Attendees

29. ที่หน้ำต่ำง Create Attendee Invitation List จะปรำกฏรำยชื่อที่เลือก
ขึ้นมำ คลิกที่ปุ่ม Select All จำกนั้นคลิกที่ปุ่ม Invite

Select All Invite
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30. ที่ Attendees คลิกที่ View invitation list จะปรำกฏหน้ำต่ำง Attendee List 
แสดงรำยชื่อผู้ที่ได้รับเชิญเข้ำร่วมกิจกรรมทั้งหมด

31. ที่ Invite friends คลิกที่ Allow registrants to invite friends to this event  
เพื่อสำมำรถส่งต่อกำรส่งทะเบียนเข้ำร่วมกิจกรรมให้เพื่อนได้

ที่ Maximum number of registrants: สำมำรถก ำหนดจ ำนวนผู้เข้ำร่วมกิจกรรม
สูงสุดได้

32. ที่ Registration form คลิกที่ข้อควำม here จะปรำกฏหน้ำต่ำง 
Customize Registration Questions
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33. ที่หน้ำต่ำง Customize Registration
Questions จะแสดงข้อมูลรำยละเอียดต่ำงๆ
ในกำรลงทะเบียน โดยจะไปปรำกฏที่
แบบฟอร์มกำรลงทะเบียนเข้ำร่วมกิจกรรม

34. สำมำรถเลือกใช้งำนได้ตำมต้องอำทิเช่น แบบฟอร์มลงทะเบียน ต้องกำรแค่ ชื่อ
นำมสกุลและอีเมล์ ต้องคลิกเครื่องหมำยถูกออกจำกข้อควำมที่ไม่เกี่ยวข้องท้ังหมด
ออกไป จำกนั้นคลิกที่ปุ่ม Save จะปรำกฏหน้ำต่ำง Successful! แล้วคลิกท่ีปุ่ม Close

35. ที่ Destination URL after registration : 
ใส่ URL ที่ใช้งำนหลังกำรลงทะเบียนกิจกรรม

(จำกกำรทดสอบสำมำรถใช้งำนได้ที่ https://mahidol.webex.com/ เท่ำนั้น)

ที่ Approval required : หำกต้องกำรตรวจสอบข้อมูลผู้ลงทะเบียนก่อนกำรอนุมัติ
ให้คลิกที่ข้อควำม Yes 

Save

Close

16



36.จะปรำกฏกล่องข้อควำม
ขึ้นมำให้คลิกที่ปุ่ม ตกลง

เมื่อคลิกที่ข้อควำม Set up approval 
rules จะปรำกฏหน้ำต่ำง Approval 
Rules ในกำรก ำหนดค่ำต่ำงๆในกำร
อนุมัติในกำรลงทะเบียน

37. ที่ Registration password คลิกที่ข้อควำม Yes, 
specify password : พิมพ์รหัสที่ต้องกำรใช้งำนลงไป

ที่ Registration ID required : เลือกกำรตั้งค่ำที่ระบบก ำหนดไว้

38. ที่ข้อควำม Presenters & Panelists : มีกำรตั้งค่ำต่ำงๆ ดังนี้
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39. ที่ Panelists คลิกที่ Create invitation 
list จะปรำกฏหน้ำต่ำง Create Panelists 
Invitation List คลิกที่ปุ่ม Select Contacts
เฉพำะที่มีรำยชื่อที่เคยใช้งำนมำแล้ว

Select Contacts..

40. จะปรำกฏหน้ำต่ำง Select Panelists from Your Contacts คลิกที่รำยชื่อที่
ต้องกำรเชิญร่วมกิจกรรม จำกนั้นคลิกที่ปุ่ม Add Panelist

Add Panelist

41. ที่หน้ำต่ำง Create Panelists Invitation List จะปรำกฏรำยชื่อที่เลือกขึ้นมำ 
คลิกที่ปุ่ม Select All จำกนั้นคลิกที่ปุ่ม Invite

Select All Invite
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42. ที่ Panelists คลิกที่ View invitation list จะปรำกฏหน้ำต่ำง Panelist List 
แสดงรำยชื่อผู้ที่ได้รับเชิญเข้ำร่วมกิจกรรมทั้งหมด

43. ที่ Panelists info : สำมำรถใส่ข้อมูลของ Panelists ได้ และ คลิกเครื่องหมำย
ถูก ที่ Allow panelists to upload documents associated with the event.
เพื่อให้ สำมำรถอัพโหลดไฟล์ข้อมูล ใช้ในกิจกรรมได้

ที่ Panelists Password และ Confirm Password  สำมำรถตั้งรหัสผ่ำนได้

44. ที่ Email Messages จะเป็นกำรตั้งค่ำข้อควำม
ในกำรส่งอีเมล์ในกรณีต่ำงๆ ในทีนี้ ขอยกตวัอยำ่ง
กำรส่งอีเมล์เชิญผู้เข้ำร่วมงำนและลงทะเบียน
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45. ที่ Invitation emails คลิกที่ 
Attendees จะปรำกฏหน้ำต่ำง Event
Email Attendee Invitation… ขึ้นมำ 
แสดงข้อควำมฟอร์มตัวอย่ำงในกำรส่ง
อีเมล์ จำกนั้นคลิกที่ปุ่ม Edit 

Edit 

46. จะปรำกฏหน้ำต่ำง Edit Event Email Attendee Invitation… ขึ้นมำ
ที่ช่อง Email Body คลิก เลือกข้อควำมทั้งหมด

47. เปิดโปรแกรม notepad แล้ววำงข้อควำมทั้งหมดลงไป
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48. ลองแก้ไขข้อควำมให้เป็นข้อควำมเชิญชวนจำกหน่วยงำน

จำกนั้นคลิกเลือกข้อควำมทั้งหมด
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49. ที่หน้ำต่ำง Edit Event Email Attendee Invitation… ที่ช่อง Email Body 
คลิก เลือกข้อควำมทั้งหมดแล้วลบทิ้ง

จำกนั้นน ำข้อควำมจำกโปรแกรม notepad มำใช้แทนแล้วคลิกปุ่ม Preview

Preview

50. จะปรำกฏข้อควำมที่ได้แก้ไขไว้ เลื่อนดูข้อควำมทั้งหมดแล้วคลิกปุ่ม Close
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51. ที่หน้ำต่ำง Edit Event Email Attendee Invitation… คลิกปุ่ม Save
จะปรำกฏหน้ำต่ำง Event Email Attendee Invitation… ที่แก้ไขข้อควำม
เรียบร้อยแล้วข้ึนมำ

52. เมื่อจบกำรตั้งกำรใช้งำนต่ำงๆแล้วให้คลิกที่ปุ่ม Schedule This  Event

Schedule This  Event

53. จะปรำกฏข้อควำม Send Event Emails

Save
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54. ที่ข้อควำม Send invitation emails to : คลิกเลือกส่งอีเมล์ที่ข้อควำม 
Panelists และ Attendees แล้วคลิกที่ปุ่ม Send Now

จะปรำกฏกล่องข้อควำมคลิกที่ปุ่ม ตกลง

55. จะปรำกฏข้อควำม Email confirmed เมื่อลองคลิกที่ปุ่ม Continue

Continue
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56. จะปรำกฏข้อควำม Event Information แสดงข้อมูลรำยละเอียดกำรตั้งค่ำ
ต่ำงๆที่ได้ก ำหนดขึ้น

Manage Registrations

เมื่อลองคลิกที่ปุ่ม Manage Registrations
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57. จะปรำกฏข้อควำม Manage Registrations : ……. ขึ้นมำ 
เมื่อมีผู้เริ่มลงทะเบียนเข้ำร่วมกิจกรรม จะมำปรำกฏที่หน้ำนี้

จบขั้นตอนกำรตั้งคำ่ใชง้ำน
Cisco Webex Events 
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กำรลงทะเบียนกำรเข้ำร่วมกิจกรรม
Cisco Webex Events 
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1. ที่อีเมล์ของผู้ที่ได้รับเชิญร่วมลงทะเบียนกิจกรรมแบบ Panelists
จะปรำกฏอีเมล์ชื่อ Invitation to join Web seminar as a panelist: ………
ให้คลิกที่ปุ่ม Join event

Join event

2. จะปรำกฏข้อควำม Event Information : ……… 
แสดงรำยละเอียดกิจกรรม
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3. จำกนั้นพิมพ์ข่ือนำมสกุลที่
ต้องกำรใช้งำนลงไป  จำกนั้น
คลิกที่ปุ่ม Submit

Submit

4. เนื่องจำกยังไม่ถึงช่วงเวลำกิจกรรมเริ่มต้นจึงไม่สำมำรถเข้ำร่วมได้ แต่จะปรำกฏ
ปุ่ม Upload ขึ้นมำตำมที่ได้ตั้งค่ำไว้ จำกนั้นคลิกที่ปุ่ม Upload

Upload

5. จะปรำกฏหน้ำต่ำง Upload Event Flie คลิกที่ปุ่มเลือกไฟล์ตำมล ำดับ 
แล้วเลือกไฟล์ที่ต้องกำรคลิกปุ่ม Open 
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เมื่อเลือกไฟล์ครบตำมจ ำนวนแล้ว คลิกปุ่ม OK

6. จะปรำกฏไฟล์ต่ำงๆที่เลือกไว้ปรำกฏขึ้นมำที่ Event Flie

7. เมื่อถึงเวลำเริ่มกิจกรรมและ Host เปิดกิจกรรมเรียบร้อย 
กลับมำที่อีเมล์ Invitation to join Web seminar as a panelist : ………
คลิกที่ปุ่ม Join event เข้ำร่วมกิจกรรมได้ทันที

Join event

30



8. ส่วนที่ Manage Registrations : ……. จะไม่เกี่ยวข้องกับ Panelists
ต้องรอผู้ลงทะเบียนเข้ำร่วมกิจกรรม

9. ที่อีเมล์ของผู้ที่ได้รับเชิญร่วมลงทะเบียนกิจกรรมแบบ Attendees
จะปรำกฏอีเมล์ชื่อ Invitation to Web seminar: ………… และที่แสดงข้อควำม
เชิญชวนที่ได้แก้ไขไว้ปรำกฏขึ้นมำ คลิกที่ปุ่ม Register

Register

10. จะปรำกฏข้อควำม Event Information : ……… แสดงรำยละเอียดกิจกรรม
คลิกที่ปุ่ม Register

Register
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11. จะปรำกฏข้อควำม Register Password แล้ว พิมพ์รหัส ที่ได้รับที่ช่อง 
Register Password คลิกที่ปุ่ม Submit

Submit

12. จำกนั้น พิมพ์ช่ือ - นำมสกุล ที่ต้องกำรใช้งำนลงไป  จำกนั้นคลิกที่ปุ่ม Submit

Submit

13. จะปรำกฏข้อควำม Registration Pending ขึ้นมำ
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14. ที่ข้อควำม Invite a Friend 
สำมำรถพิมพ์อีเมล์ของเพี่อนเพื่อส่ง
ต่อกิจกรรมนี้ได้

15. ที่ Manage Registrations : ……. เมื่อมีผู้เริ่มลงทะเบียนเข้ำร่วม
กิจกรรมจะปรำกฏดังนี้

16. ที่คลิกที่ ชื่อผู้ลงทะเบียน จะปรำกฏ Registrant Details ขึ้นมำแสดง
รำยละเอียด ข้อมูลผู้ลงทะเบียนนั้นๆ จำกนั้นคลิกที่ปุ่ม Close
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17. เมื่อตรวจสอบข้อมูลผู้ลงทะเบียนกิจกรรมเรียบร้อย คลิกที่แท๊บ Panding

Panding

18.คลิกข้อควำม Select All แล้วคลิกที่ปุ่ม Accept จะปรำกฏกล่องข้อควำมขึ้นมำ
คลิกที่ปุ่ม ตกลง

Select All

Accept

19. ที่แท๊บ Panding รำยชื่อผู้ทั้งหมดได้รับกำรอนุมัติเรียบร้อยแล้วย้ำยรำยชื่อ
ทั้งหมดไปที่แท็บ Approved 
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20. ที่แท็บ Approved จะแสดงรำยชื่อผู้ทั้งหมดได้รับกำรอนุมัติเรียบร้อยแล้ว

21. ที่อีเมล์ของผู้ที่ได้รับเชิญร่วมลงทะเบียนกิจกรรมแบบ Attendees
จะปรำกฏอีเมล์ชื่อ Registration approved for Web seminar : ……..
คลิกที่ปุ่ม Join Event

Join Event

22. จะปรำกฏข้อควำม Event Information : ……… แสดงรำยละเอียดกิจกรรม
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23. เมื่อถึงเวลำเริ่มกิจกรรมและ Host เปิดกิจกรรมเรียบร้อย 
กลับมำที่อีเมล์ Registration approved for Web seminar : ……..
คลิกที่ปุ่ม Join event เข้ำร่วมกิจกรรมได้ทันที

จบขั้นตอนกำรลงทะเบียนกำรเข้ำร่วมกิจกรรม
Cisco Webex Events 

Join Event
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ขั้นตอนกำรใชง้ำน
Cisco Webex Events 
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1. ที่อีเมล์ของผู้จัดสัมมนำออนไลน์ จะได้รับอีเมล์แจ้งเตือน เริ่มใช้งำนกิจกรรมที่
สร้ำงไว้ จำกนั้นคลิกที่ปุ่ม Start event 

2. จะปรำกฏข้อควำม Starting Webex ขึ้นมำ

3. จำกนั้นที่หน้ำต่ำง cisco webex event  จะแสดงภำพวิดีโอและระบบเสียงที่ได้
เชื่อมต่อไว้ขึ้นมำ จำกนั้นคลิกที่ปุ่ม Start event จะปรำกฏโปรแกรม
cisco webex event ขึ้นมำพร้อมใช้งำน

Start event 
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4. ที่อีเมล์ของผู้ร่วมอภิปรำย(Panelists) ให้คลิกที่ปุ่ม Join event

Panelists

5. จะปรำกฏหน้ำ Event Information : …. ที่ Join Event Now as Panelists 
ให้ พิมพ์ชื่อ-นำมสกุล แล้วคลิกที่ปุ่ม Submit จะกลำยเป็นปุ่ม Join แล้วคลิก
เพื่อเข้ำร่วมกิจกรรม

6. จำกนั้นที่หน้ำต่ำง cisco webex event  จะแสดงภำพวิดีโอและระบบเสียงที่ได้
เชื่อมต่อไว้ขึ้นมำ จำกนั้นคลิกที่ปุ่ม Start event จะปรำกฏโปรแกรม cisco webex
event ขึ้นมำพร้อมใช้งำน พร้อมภำพวิดีโอของผู้จัดสัมมนำออนไลน์ขึ้นมำ 

Join

Submit
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7. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ก็จะปรำกฏภำพ
วิดีโอของผู้ร่วมอภิปรำยขึ้นมำ เมื่อคลิกที่ปุ่ม Participants ก็จะปรำกฏรำยชื่อ
ของผู้ร่วมอภิปรำยขึ้นมำ

Participants

8. จำกนั้นมอบสิทธิ์กำร
น ำเสนอให้กับผู้ร่วม
อภิปรำยเพื่อทดสอบกำร
น ำเสนอเอกสำรกำร
บรรยำย โดยคลิกที่ปุ่ม 
Presenter แล้ว ลำกปุ่ม 
Presenter มำยัง ชื่อของ
ผู้เข้ำร่วมอภิปรำย

คลิกที่ปุ่ม Yes หน้ำต่ำง Change Presenter จะปรำกฏข้อควำม
You’re now the Presenter 
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9. ที่หน้ำต่ำง cisco webex event ของผู้เข้ำร่วมอภิปรำย เมื่อได้รับกำรมอบสิทธิ์
กำรน ำเสนอแล้ว คลิกที่ปุ่ม Share Content แล้วคลิกเอกสำรกำรบรรยำยที่
ต้องกำรใช้งำน

Share Content 

10. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ เมื่อผู้เข้ำร่วม
อภิปรำยทดสอบกำรน ำเสนอเรียบร้อยแล้ว คลิกขวำที่ชื่อของผู้จัดสัมมนำออนไลน์
เอง เลือกที่ค ำสั่ง Change Role To > Presenter เพื่อคืนสิทธิ์กำรน ำเสนองำน

Change Role To > Presenter 

คลิกขวำ
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11. จะปรำกฏหน้ำต่ำง Change Presenter คลิกที่ปุ่ม Yes จะข้ึนข้อควำม
You’re now the Presenter 

12. ที่อีเมล์ของผู้เข้ำร่วมกิจกรรม (Attendee) ให้คลิกที่ปุ่ม Join event

Attendee

13. ที่ผู้ร่วมกิจกรรมท่ำนที่ 1( iPad) 
จะปรำกฏ cisco webex event  ขึ้นมำ
จะแสดงระบบเสียงที่ได้เชื่อมต่อไว้ แสดง
ภำพวิดีโอของผู้จัดสัมมนำออนไลน์และ
ผู้ร่วมอภิปรำยขึ้นมำ 
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เมื่อคลิกที่ปุ่ม Participants จะแสดงรำยชื่อของ ผู้จัดสัมมนำออนไลน์,
ผู้ร่วมอภิปรำยกับผู้ร่วมกิจกรรมท่ำนที่ 1 เท่ำนั้น

Participants

14. ที่ผู้ร่วมกิจกรรมท่ำนที่ 2 (huawei) จะปรำกฏ cisco webex event  ขึ้นมำจะ
แสดงระบบเสียงที่ได้เชื่อมต่อไว้ แสดงภำพวิดีโอของผู้จัดสัมมนำออนไลน์และผู้ร่วม
อภิปรำยข้ึนมำ เมื่อคลิกที่ปุ่ม Participants จะแสดงรำยชื่อของ ผู้จัดสัมมนำ
ออนไลน์,ผู้ร่วมอภิปรำยกับผู้ร่วมกิจกรรมท่ำนที่ 2 เท่ำนั้น

Participants
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15. ที่ผู้ร่วมกิจกรรมท่ำนที่ 3 (iPhone) จะปรำกฏ cisco webex event  ขึ้นมำจะ
แสดงระบบเสียงที่ได้เชื่อมต่อไว้ แสดงภำพวิดีโอของผู้จัดสัมมนำออนไลน์และผู้ร่วม
อภิปรำยขึ้นมำ เมื่อคลิกที่ปุ่ม Participants จะแสดงรำยชื่อของ ผู้จัดสัมมนำ
ออนไลน์, ผู้ร่วมอภิปรำยกับผู้ร่วมกิจกรรมท่ำนที่ 3 เท่ำนั้น

16. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ก็จะ ปรำกฏจ ำนวน
ผู้ที่เข้ำร่วมกิจกรรมที่ Attendee เมื่อคลิกที่ View all Attendees ก็จะปรำกฏ
Attendee List แสดงรำยชื่อของผู้ที่เข้ำร่วมกิจกรรมขึ้นมำ

View all Attendees 

17. ที่หน้ำต่ำง Attendee List มีเครื่องมือกำรท ำงำนดังนี้

Find

Unmute 
Make Panelists 

Expel

: ค้นหำรำยชื่อผู้ที่เข้ำร่วมกิจกรรม

: จะให้สิทธิ์กำรสนทนำแก่ผู้ที่เข้ำร่วมกิจกรรม

: จะให้มอบสิทธิ์กำรเป็นผู้ร่วมอภิปรำย

: จะถูกเชิญออกจำกกิจกรรม
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18. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ เมื่อเริ่มมี
ผู้เข้ำร่วมกิจกรรมแล้วให้บันทึกวิดีโอกำรสัมมนำออนไลน์โดยคลิกที่ปุ่ม Record 

Record

19. แล้วคลิกที่ปุ่ม Share Content  เลือก คลิกแชร์ที่ภำพข้อควำมที่จัดเตรียมไว้

Share Content 

20. จะปรำกฏภำพข้อควำมที่แชร์เต็มหน้ำจอ
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21. เมื่อถึงกำรเริ่มต้นกิจกรรม คลิกที่ค ำสั่ง Share > File (Including Video) 
เลือก ไฟล์วิดีโอแนะน ำกิจกรรมที่เตรียมไว้ คลิกปุ่ม Open

22. จะปรำกฏกำรโหลดไฟล์วิดีโอ
แนะน ำกิจกรรมที่หน้ำจอและที่
หน้ำต่ำง Cisco webex event 
คลิกที่ปุ่ม OK OK

Open

23. จะปรำกฏหน้ำต่ำง Share Media 
File คลิกที่ปุ่ม Continue

วิดีโอจะเริ่มเล่นไปแสดงที่เครื่องของผู้เข้ำร่วมกิจกรรม 3

Continue
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24. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) จะปรำกฏวิดีโอแนะน ำกิจกรรมที่ถูกแชร์มำ

ก่อนเปิดเล่นวิดีโอ เมื่อเล่นวิดีโอภำพวิดีโอของทั้งสองช่องถูกปิดโดย
อัตโนมัติ

25. ที่หน้ำต่ำง cisco webex event ของผู้จัดสัมมนำออนไลน์ เมื่อวิดีโอแนะน ำ
กิจกรรมจบลง คลิกที่ ชื่อวิดีโอ แล้วคลิกที่ ปุ่ม Close จะปรำกฏหน้ำต่ำง Close 
Content Tab คลิกที่ปุ่ม Yes

Close
Yes
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26. จำกนั้นมอบสิทธิ์กำรน ำเสนอให้กับผู้ร่วมอภิปรำยเพื่อน ำเสนอเอกสำรกำร
บรรยำย โดยคลิกที่ชื่อของผู้เข้ำร่วมอภิปรำยเลือกที่ค ำสั่ง Change Role To > 
Presenter จะปรำกฏหน้ำต่ำง Change Presenter คลิกที่ปุ่ม Yes

Change Role To > Presenter 

จะปรำกฏข้อควำม You’re now the Presenter 

27. ที่หน้ำต่ำง cisco webex event ของผู้เข้ำร่วมอภิปรำย เมื่อได้รับกำรมอบ
สิทธิ์กำรน ำเสนอแล้ว คลิกที่ปุ่ม Share Content แล้วคลิก เอกสำรกำรบรรยำย
ที่ต้องกำรใชง้ำน

Share Content 
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28. จะปรำกฏภำพเอกสำรกำรบรรยำยที่แชร์เต็มหน้ำจอ

29. เริ่มบรรยำยตำมเอกสำร

30. เมื่อกำรบรรยำยสิ้นสุดลง คลิกที่ปุ่ม Stop Sharing

Stop Sharing 
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31. ผู้ร่วมอภิปรำยสำมำรถแชทข้อควำมให้ผู้ร่วมกิจกรรรมได้ 
ด้วยกำรคลิกที่ ช่อง chat

32. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) จะปรำกฏข้อควำมที่ถูกส่งมำที่ปุ่ม
Participants > chat

33. หำกผู้ร่วมกิจกรรมต้องกำรสอบถำมให้คลิกปุ่ม Raise Hand

Participants

Raise Hand

chat
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34. ที่หน้ำต่ำง cisco webex event ของผู้เข้ำร่วมอภิปรำย จะปรำกฏเครื่องหมำย 
Raise Hand ขึ้นมำที่รำยชื่อผู้ร่วมกิจกรรม 

35. จำกนั้นผู้เข้ำร่วมอภิปรำยสำมำรถให้สิทธิ์
กำรสนทนำแก่ผู้ร่วมกิจกรรมได้คลิกที่ปุ่ม 
Unmute ก็จะได้ยินของผู้ร่วมกิจกรรมได้  

Unmute

36. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) เมื่อผู้เข้ำร่วมอภิปรำยเห็นปุ่ม Raise Hand 
แล้วให้คลิกที่ ปุ่ม Raise Hand อีกครั้ง เพื่อเอำเครื่องหมำย Raise Hand ลง

Raise Hand
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37. จำกนั้นมอบสิทธิ์กำรน ำเสนอคืนกลับให้กับผู้จัดสัมมนำออนไลน์
โดยคลิกที่ชื่อของผู้จัดสัมมนำออนไลน์เลือกที่ค ำสั่ง Change Role To > 
Presenter คลิกที่ปุ่ม Yes หน้ำต่ำง Change Presenter จะปรำกฏข้อควำม
You’re now the Presenter 

38. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ เลือกที่ค ำสั่ง 
File > Open and Share เลือก ไฟล์ที่ต้องกำรน ำเสนอ คลิกปุ่ม Open

จะปรำกฏข้อมูลกำรน ำเสนอเต็มหน้ำจอ เริ่มกำรน ำเสนอของผู้จัดสัมมนำออนไลน์

File > Open and Share 
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39. เมื่อกำรน ำเสนอของผู้จัดสัมมนำออนไลน์ จบลงคลิกที่ชื่อไฟล์น ำเสนอคลิก
ปุ่ม Close จะปรำกฏหน้ำต่ำง Cisco webex event คลิกปุ่ม Yes

Close

40. ผู้จัดสัมมนำออนไลน์เปิดโอกำสให้ผู้เข้ำร่วมกิจกรรมได้ถำมตอบผ่ำน
เครื่องมือ Q&A

41. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) คลิกที่ ปุ่ม … เลือก Q&A 
จะปรำกฏแถบ Ask a Question คลิกที่ Ask a Question

Q&A Ask a Question 
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42. พิมพ์ค ำถำมลงไปจำกนั้น คลิกที่ปุ่ม Send ค ำถำมจะมำแสดงที่หน้ำ
Ask a Question

43. ที่ช่อง Q&A ของผู้จัดสัมมนำออนไลน์ จะปรำกฏค ำถำมจำกผู้เข้ำร่วมกิจกรรม 
คลิกที่ค ำถำมนั้น แล้ว พิมพ์ค ำตอบที่ช่องข้อควำม แล้วคลิกที่ปุ่ม Send
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44. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) จะปรำกฏค ำตอบจำกผู้จัดสัมมนำออนไลน์ 
ที่แถบ Ask a Question แต่ก็จะไปปรำกฏที่แถบ Ask a Question เครื่องผู้ร่วม
กิจกรรมท่ำนอื่นด้วยเช่นกัน

45. หำกผู้ร่วมกิจกรรมต้องกำรให้ตอบ
ค ำถำมแบบส่วนตัว ก็พิมพ์ค ำถำมลง
ไปจำกนั้น คลิกที่ปุ่ม Send

Send

46. ที่ช่อง Q&A ของผู้จัดสัมมนำออนไลน์ หำกยังไม่มีค ำถำมปรำกฏ คลิกขวำ
เลือก Unanswered > Open Tab จะปรำกฏค ำถำมจำกผู้เข้ำร่วมกิจกรรมขึ้นมำ

Unanswered > Open Tab
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47. คลิก ที่ค ำถำม จำกผู้เข้ำร่วมกิจกรรมที่ระบุให้ตอบแบบส่วนตัว คลิกที่ค ำถำม
นั้นแล้ว พิมพ์ค ำตอบ ที่ช่องข้อควำม แล้วคลิกที่ปุ่ม Send Privately จะปรำกฏ
หน้ำต่ำง Respond Privately เลือกที่ Answer Privately คลิกที่ปุ่ม Send

Send Privately

48. ที่เครื่องผู้ร่วมกิจกรรม (iPad) จะปรำกฏค ำตอบจำกผู้จัดสัมมนำออนไลน์
แบบส่วนตัว ที่แท๊บ Ask a Question
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49. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ หำกต้องเก็บ
ข้อมูล Q&A โดยทันที เลือกที่ค ำสั่ง File > Save > Questions and Answers
เลือกพื้นที่เก็บไฟล์คลิกปุ่ม Save

ตัวอย่ำงไฟล์

50. ที่หน้ำต่ำง cisco webex event  
ของผู้จัดสัมมนำออนไลน์ หำกต้องกำรให้
ผู้เข้ำร่วมกิจกรรมได้ปฏิบัติกิจกรรมตำมสั่ง
ที่ก ำหนดให้คลิกที่ Event > Start Practice 
Session
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ที่หน้ำต่ำง Webex Recorder คลิกที่ปุ่ม continue Recording (จะแสดงเมื่อ
บันทึกวิดีโอไว้) ที่หน้ำต่ำง Cisco Webex Event คลิกที่ปุ่ม OK

51. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) 
จะปรำกฏข้อควำม Panelists are 
now in a Practice Session

52. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ เมื่อผู้เข้ำร่วม
กิจกรรมได้ปฏิบัติกิจกรรมตำมสั่งเรียบร้อยแล้ว ให้คลิกที่ 
Event > End Practice Session ที่หน้ำต่ำง Cisco Webex Event คลิกที่ปุ่ม OK
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53. เมื่อถึงเวลำปิดกำรสัมมนำออนไลน์ ผู้จัดสัมมนำออนไลน์ กล่ำวปิดแล้ว คลิก
ที่ปุ่ม End or leave event > End Event

54. จะปรำกฏหน้ำต่ำง End Event คลิกเลือกที่ข้อควำม Save event files 
จะมีข้อมูลกำรใช้งำนเครื่องมือระหว่ำงกิจกรรมข้ึนเลือกที่จัดเก็บไฟล์แล้วคลิกที่
ปุ่ม End Event

จบขั้นตอนกำรใชง้ำน
Cisco Webex Events 
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ขั้นตอนกำรใชง้ำน Poll
Cisco Webex Events 
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1. ที่หน้ำต่ำง cisco webex event ของผู้จัดสัมมนำออนไลน์ เมื่อต้องกำร
ท ำแบบส ำรวจ สำมำรถงำนเครื่องมือ Poll ได้ โดยสังเกตว่ำมีช่อง Polling  
แสดงตำมภำพหรือไม่

2. หำกยังไม่มีเครื่องมือนี้ปรำกฏให้คลิกที่ File > Open Poll Questions
จะปรำกฏข้อควำม Cisco webex event  คลิกปุ่ม OK 

จะแสดงพื้นที่จัดเก็บไฟล์ Poll Questions 
ขึ้นมำ ถ้ำยังไม่เคยสร้ำงไว้ให้คลิกปุ่ม 
Cancel

Polling 
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3. เมื่อเครื่องมือนี้ปรำกฏให้ใช้งำนแล้ว โดยแสดงรำยกำรเป็นชื่อ poll 1

poll 1

4. เมื่อคลิกที่ปุ่ม Options จะปรำกฏ Polling Options มีค ำสั่งใช้งำนดังนี้

 Timer :
Display : เพื่อแสดงเวลำในกำรท ำแบบส ำรวจ
Alarm : ตั้งเตือนเวลำที่ต้องกำรให้ท ำแบบส ำรวจได้
 Poll results ( ที่ผลกำรส ำรวจ)
indude no answer : ให้แสดงข้อที่ไม่มีค ำตอบ
show number response : ให้แสดงจ ำนวนกำรตอบกลับ
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5. เริ่มต้นสร้ำงแบบส ำรวจที่ 1
ที่ Question เลือก Type > Multiple 
choice > Single Answer แล้วคลิก
ที่ปุ่ม Add New Question  

6. ที่ Poll Questions  จะปรำกฏช่อง
ข้อควำมขึ้น พิมพ์ค ำข้อควำมที่ต้องกำร
ใช้งำนลงไป 

7. จำกนั้นคลิกที่ปุ่ม Add an Answer จะปรำกฏช่องข้อควำมขึ้นมำใส่ข้อควำม
ตัวเลือกของแบบส ำรวจลงไป แล้วเพิ่มจ ำนวนตัวเลือก ที่ต้องกำร
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8. เริ่มต้นสร้ำงแบบส ำรวจที่ 2 คลิกที่ปุ่ม New จะปรำกฏแท็บชื่อของ poll ล ำดับ
ถัดไปขึ้นมำ ที่ Question เลือก Type > Multiple choice > Multiple Answer

9. คลิกที่ปุ่ม Add New Question จะปรำกฏช่องช้อควำมขึ้น พิมพ์ค ำข้อควำม
ที่ต้องกำรใช้งำนลงไป 

10. จำกนั้นคลิกที่ปุ่ม Add an Answer จะปรำกฏช่องข้อควำมขึ้นมำใส่ข้อควำม
ตัวเลือกของแบบส ำรวจลงไป แล้ว เพิ่มจ ำนวนตัวเลือก ที่ต้องกำร
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11. เริ่มต้นสร้ำงแบบส ำรวจที่ 3 คลิกที่ปุ่ม New จะปรำกฏแท็บชื่อของ poll ล ำดับ
ถัดไปขึ้นมำ ที่ Question เลือก Type > Short Answer

12. คลิกที่ปุ่ม Add New Question จะปรำกฏช่องช้อควำมขึ้น พิมพ์ค ำข้อควำม
ที่ต้องกำรใช้งำนลงไป 

13. จำกนั้นคลิกที่ปุ่ม Add an Answer จะปรำกฏช่องข้อควำมขึ้นมำ ใส่ข้อควำม
ตัวเลือกของแบบส ำรวจ ลงไป  
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แล้วเพิ่มจ ำนวนข้อแบบส ำรวจกับตัวเลือกที่ต้องกำร

14. หำกต้องกำรเก็บแบบส ำรวจไว้ใช้ครั้งต่อไป ให้คลิกที่ปุ่ม Save ในแท็บ Poll 
ที่ต้องกำร จะปรำกฏหน้ำต่ำง Save Poll Questions As เลือกพื้นที่จัดเก็บคลิกที่
ปุ่ม Save
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15. เมื่อแบบส ำรวจเรียบร้อยแล้วคลิกที่แท็บ Poll ที่ต้องกำรส่งส ำรวจ แล้วคลิกที่
ปุ่ม Open Poll จะปรำกฏหน้ำต่ำง Cisco webex event คลิกปุ่ม OK

16. ที่แท็บ Poll จะแสดงรำยละเอียด
ต่ำงๆ หลังจำกส่ง Poll ไปแล้ว

17. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) 
จะปรำกฏข้อควำม Polling คลิกที่
ปุ่ม OK เพื่อตอบแบบส ำรวจ 
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18. จะปรำกฏแบบส ำรวจที่ส่งมำที่ Poll Questions จำกนั้นตอบแบบส ำรวจ
ด้วยกำร คลิกเลือกตัวเลือก ที่ต้องกำร จำกนั้นคลิกที่ปุ่ม Submit จะปรำกฏ
ข้อควำม Polling คลิกที่ปุ่ม Submit อีกครั้ง 

19. ที่ช่อง Polling ของผู้จัดสัมมนำ
ออนไลน์  แท็บ Poll ที่ได้ส่งแบบส ำรวจ
ไป จะแสดงรำยละเอียดกำรตอบแบบ
ส ำรวจกลับเข้ำมำ และแสดงข้อมูลแบบ
ส ำรวจที่ตอบกลับครบแล้วที่ 
Polling Status : Finished 
จำกนั้นคลิกที่ปุ่ม Close Poll 

20. หำกไม่ต้องเผยแพร่ผลส ำรวจนี้ให้
คลิกที่ปุ่ม Clear All จะปรำกฏหน้ำต่ำง 
webex Polling คลิกที่ปุ่ม Yes 
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แล้วเลือกพื้นที่จัดเก็บไฟล์ Poll เพื่อเก็บ
แบบส ำรวจไว้ใช้งำนครั้งต่อไป

21. จะปรำกฏหน้ำต่ำง webex Polling คลิกที่ปุ่ม Yes แล้วเลือกพื้นที่จัดเก็บไฟล์ 
Poll Result เพื่อเก็บผลสรุปของกำรตอบแบบส ำรวจในกำรสรุปงำนต่อไป

ตัวอย่ำงไฟล์

22. เมื่อแบบส ำรวจที่ตอบกลับครบ
แล้วคลิกที่ปุ่ม Close Poll 
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เมื่อตอ้งเผยแพรผ่ลส ำรวจนี้ ให้คลิกที่ Poll results แล้วคลิกที่ปุ่ม Apply

23. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) จะปรำกฏข้อควำม Polling คลิกที่ปุ่ม OK 
เพื่อรับทรำบผลสรุปกำรตอบแบบส ำรวจนี้ 

24. ที่ช่อง Polling ของผู้จัดสัมมนำ
ออนไลน์  คลิกเลือกแท็บ Poll7
ที่ต้องกำรส่งแบบส ำรวจไป จำกนั้น
คลิกที่ข้อควำม Record Individual 
results แล้วคลิกปุ่ม Open Poll

70



25. เมื่อแบบส ำรวจที่ตอบกลับครบ แล้วคลิกที่ปุ่ม Close Poll 
เมื่อตอ้งเผยแพรผ่ลส ำรวจนีแ้บบ Individual results ให้คลิกที่เลือกที่ 
Individual results แล้วคลิกที่ปุ่ม Apply

26. จะปรำกฏกำรแชร์เพจข้ึนและแสดงข้อมูล Individual Poll results ขึ้นมำ 
แสดงรำยละเอียดต่ำงๆกำรแบบส ำรวจนี้และแสดงข้อมูลกำรตอบแบบส ำรวจของ
ผู้ร่วมเข้ำกิจกรรมด้วย
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27. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) จะปรำกฏกำรแชร์ข้อมูล
Individual Poll results ขึ้นมำ เพื่อรับทรำบผลสรุปกำรตอบแบบส ำรวจนี้ 

28. ที่หน้ำต่ำง cisco webex event  ของผู้จัดสัมมนำออนไลน์ เมื่อแสดงข้อมูล 
Individual Poll results เรียบร้อยแล้วให้คลิกปุ่ม Stop Sharing
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29. ที่ช่อง Polling8 ของผู้จัดสัมมนำออนไลน์  แล้วคลิกที่ปุ่ม Open Poll 
ส่วนที่แท็บ Poll จะแสดงรำยละเอียดต่ำงๆหลังจำกส่ง Poll ไปแล้ว

30. ที่เครื่องผู้ร่วมกิจกรรม ( iPad) 
จะปรำกฏข้อควำม Polling คลิกที่ปุ่ม 
OK เพื่อตอบแบบส ำรวจ 

31. จะปรำกฏแบบส ำรวจที่ส่งมำที่ Polli Questions จำกนั้น
พิมพ์ข้อควำมตอบกลับแบบส ำรวจ
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32. แล้วคลิกที่ปุ่ม Submit จะปรำกฏข้อควำม Polling คลิกที่ปุ่ม Submit อีกครั้ง 

34. ที่ช่อง Polling ของผู้จัดสัมมนำออนไลน์  แท็บ Poll8 ที่ได้ส่งแบบส ำรวจไป
จะแสดงรำยละเอียดกำรตอบแบบส ำรวจกลับเข้ำมำ และแสดงข้อมูลแบบส ำรวจที่
ตอบกลับครบแล้วที่ Polling Status : Finished จำกนั้นคลิกที่ปุ่ม Close Poll
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35. หำกไมต่อ้งเผยแพรผ่ลส ำรวจ นี้ให้คลิกที่ปุ่ม Clear All จะปรำกฏหน้ำต่ำง 
webex Polling คลิกที่ปุ่ม Yes แล้ว เลือกพื้นที่จัดเก็บไฟล์ Poll เพื่อเก็บแบบ
ส ำรวจไว้ใช้งำนครั้งต่อไป

36. จะปรำกฏหน้ำต่ำง webex Polling คลิกที่ปุ่ม Yes แล้ว เลือกพื้นที่จัดเก็บไฟล์ 
Poll Result เพื่อเก็บผลสรุปของกำรตอบแบบส ำรวจในกำรสรุปงำนต่อไป
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ตัวอย่ำงไฟล์

จบขั้นตอนกำรใชง้ำน Poll
Cisco Webex Events 
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